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Chapter 706 

Non-Inferiority 
Logrank Tests 
Introduction 
This module computes the sample size and power for non-inferiority tests under the assumption of proportional 
hazards. Accrual time and follow-up time are included among the parameters to be set. The non-inferiority 
logrank test is used for data analysis. 

Sometimes, the objective of a study is to show that an experimental therapy is not inferior to (no worse than) the 
standard therapy. The experimental therapy may be cheaper, less toxic, or have fewer side effects. Such studies 
are often called non-inferiority trials and have a one-sided hypothesis. 

Power and sample size calculations for the non-inferiority logrank test have been developed by Jung et al. (2005), 
and we use their results. These calculations assume an underlying exponential survival distribution with a uniform 
patient accrual pattern during the accrual period.  

Technical Details 

Test Statistic 
Suppose a clinical trial consists of two independent groups. Designate group one as the standard group with 
hazard rate h1 and sample size n1. Designate group two as the experimental group with hazard rate h2 and sample 
size n2. The total sample size is N = n1  + n2 . Usually, you would plan to have n1  = n2 .  

Define the proportion of the total sample in each group as 

i
iQ  =  n

N
,   i =1,2  

Individuals are recruited during an accrual period of R years (or months or days). They are followed for an 
additional period of time until a total of T years is reached. Hence, the follow-up period is T-R years. At the end of 
the study, the non-inferiority logrank test is conducted at significance level α  with power 1− β . Under the 
proportion hazards assumption, the hazard ratio HR = h2 / h1 is constant across time.  

For a given non-inferiority margin HR0 (>1) (the maximum ratio of clinical insignificance), the statistical 
hypotheses tested are 

0100 :.: HRHRHvsHRHRH <≥  
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Define the partial score function as 
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and the information function as 
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where kiX  is the minimum of the survival time, and the censoring time, kiδ ,is an event indicator taking 1 if there 
was an event or 0 otherwise, and I(.) is an indicator function. Note that W(1) is the standard logrank test statistic. 

Under 0H , ( ) ( )00 / HRHRW Nσ  is asymptotically normal with mean 0 and variance 1. Reject 0H in favor of 1H  
if  ( ) ( )00 / HRHRW Nσ > α−1z  with one-sided type I error probability α . 

The partial MLE, RĤ , is obtained by solving ( ) 0=HRW . Let *HR  denote the true value of HR. It can be 

shown that RĤ  is asymptotically normal with mean *HR  and variance ( )*2 HRN
−σ . 

An asymptotic ( )%1100 α−  confidence interval for HR is ( )RHzRH N
ˆˆ 1

2/1
−

−± σα . 

Power Calculations 
Jung (2005) shows that the power of the non-inferiority logrank test can be expressed as 
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where D is the observed number of deaths (events). The total sample size N is obtained by inflating D according 
to the relationship E(d)N = D, where E(d) is the expected death rate for the trial. 

Following the proposal of Yateman and Skene (1992) and the results of Lakatos (1988), we compute E(d) using 
the Markov Model given in chapter 715 as 

( ) 2,222,11 SQSQdE +=  

where S1,2 and S2,2 are the occupancy probabilities for the event state for the standard and experimental groups, 
respectively. This formulation allows the inclusion of loss to follow-up, noncompliance, and drop-in along with 
various accrual patterns. 
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Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
This option specifies the parameter to be solved for from the other parameters. The parameters that may be 
selected are Power or Sample Size. Select Sample Size when you want to calculate the sample size needed to 
achieve a given power and alpha level. Select Power when you want to calculate the power.  

Power and Alpha 

Power 
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, 
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null 
hypothesis is not rejected. In this procedure, a type-II error occurs when you do not reject the null hypothesis that 
the hazard ratio is greater than HR0 when in fact it is. 

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 
0.90 (Beta = 0.10) is also commonly used. 

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.  

Alpha 
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you 
reject the null hypothesis that the hazard ratio is greater than HR0 when in fact it is not. 

Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means 
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that 
represents the risk of a type-I error you are willing to take in your experimental situation.  

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.  

Sample Size 

Total Sample Size (N) 
This is the combined sample size of both groups. This amount is divided between the two groups using the value 
of the Proportion in Reference Group.  

Percent in Group 1 
This is the percent of N in the reference (control) group. If this value is labeled 1Q , the sample size of group one 
is 1NQ  and the sample size of group two is 1NQN − . Note that the value of 1NQ  is rounded to the nearest 
integer. 
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Effect Size 

HR0 (Non-Inferiority Hazard Ratio) 
Enter the non-inferiority bound for the hazard ratio. This value is used to construct the hypotheses. 

Higher Hazards Worse 
When events are bad (such as death), then this number should be > 1. The alternative hypothesis is H1: HR < 
HR0. 

Enter the maximum hazard ratio for which the treatment group will be considered non-inferior to the reference 
group. For example, if you enter 1.20 here, you are saying that hazard ratios < 1.20 will result in the conclusion of 
non-inferiority when H0 is rejected. In other words, hazard ratios up to 1.20 indicate that the treatment group is no 
worse than the reference group. 

Higher Hazards Better 
When events are good, then this number should be < 1. The alternative hypothesis is H1: HR > HR0. 

Enter the minimum hazard ratio for which the treatment group will be considered non-inferior to the reference 
group. For example, if you enter 0.8 here, you are saying that hazard ratios > 0.8 will result in the conclusion of 
non-inferiority when H0 is rejected. In other words, hazard ratios down to 0.8 indicate that the treatment group is 
no worse than the reference group. 

h1 (Hazard Rate of Reference Group) 
Specify one or more hazard rates (instantaneous failure rate) for the reference group. For an exponential 
distribution, the hazard rate is the inverse of the mean survival time. An estimate of the hazard rate may be 
obtained from the median survival time or from the proportion surviving to a certain time point. This calculation 
is automated by pressing the Parameter Conversion button. 

Hazard rates must be greater than zero. Constant hazard rates are specified by entering them directly. Variable 
hazard rates are specified as columns of the spreadsheet. When you want to specify different hazard rates for 
different time periods, you would enter those rates into a column of the spreadsheet, one row per time period. You 
specify the column (or columns) by beginning the entry with an equals sign. For example, if you have entered the 
hazard rates in column 2, you would enter =2 here.    

Duration 

Accrual Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) during which subjects are entered 
into the study. The total duration of the study is equal to the Accrual Time plus the Follow-Up Time. These values 
must be integers. 

Accrual times can range from 0 to the Total Time. That is, the accrual time must be less than or equal to the Total 
Time. Otherwise, the scenario is skipped. 

Enter 0 when all subjects begin the study together. 

Accrual Pattern 
Specify the type of accrual (patient entry) pattern. Two types of entries are possible: 

• Uniform or Equal 
If you want to specify a uniform accrual rate for all time periods, enter Equal here. 

• Non-Uniform (Spreadsheet Entry) 
Use this option when you want to specify one or more accrual patterns with different accrual rates per time 
period. You will specify the different accrual rates for each time period in the spreadsheet. 
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Accrual Values in Columns 
Specify the columns of the spreadsheet containing the different accrual (patient entry) rates. One value per row is 
entered in spreadsheet cells for each time period. Each value is the proportion of the total number of subjects that 
enroll during the corresponding time period. 

Syntax 

Enter an equals sign followed by a list of columns containing the accrual patterns. For example, if you have 
entered two sets of accrual patterns in columns 1 and 2, you would enter “=C1 C2.” 

Standardized 

Note that cell values in a column are standardized so they sum to one. Thus, the accrual patterns 2 1 1 and 50 25 
25 both result in the same accrual pattern as 0.50 0.25 0.25 . 

Number of Rows and Columns 

The number of rows in each column should equal the Accrual Time. The number of columns is up to you. A 
separate analysis is conducted for each column. 

Spreadsheet Cells 

In a specified column, the proportion of all subjects that are expected to enroll during the first time period is 
specified in row one. The proportion of all subjects that are expected during the second time period is specified in 
row two. And so on. 

For example, if you had specified three accrual-time periods and you wanted to specify double the accrual rate in 
the first period than in the other two, the spreadsheet would appear as 

C1 
2 
1 
1 

Total Time (Integers Only) 
Enter one or more values for the number of time periods (months, years, etc.) in the study. The follow-up time is 
equal to the Total Time minus the Accrual Time. These values must be integers. 

Proportion Lost or Switching Groups 

Reference (or Treatment) Lost 
This is the proportion of subjects in the reference (treatment) group that are lost to follow up (i.e. censored) during 
a single time period (month, year, etc.). Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter those proportions into 
a column of the spreadsheet, one row per time period. You specify the column of the spreadsheet by beginning 
your entry with an equals sign. For example, if you have entered the proportions in column 5, you would enter 
=C5 here. 

Reference Switching to Treatment 
This is the proportion of subjects in the reference group that change to a treatment regime similar in efficacy to 
the treatment group during a single time period (month, year, etc.). This is sometimes referred to as drop in. 
Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter those values into a 
column of the spreadsheet, one row per time period. You specify the column of the spreadsheet by beginning your 
entry with an equals sign. For example, if you have entered the proportions in column 1, you would enter =C1 
here. 
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Treatment Switching to Reference 
This is the proportion of subjects in the treatment group that change to a treatment regime similar in efficacy to 
the reference group during a single time period (month, year, etc.). This is sometimes referred to as 
noncompliance. Multiple entries, such as 0.01 0.03 0.05, are allowed. 

When you want to specify different proportions for different time periods, you would enter those values into a 
column of the spreadsheet, one row per time period. You specify the column of the spreadsheet by beginning your 
entry with an equals sign. For example, if you have entered the proportions in column 2, you would enter =C2 
here. 

Reports Tab 
The Reports tab contains additional settings for this procedure.  

Report Column Width 

Report Column Width 
This option sets the width of the each column of the numeric report. 

The numeric report for this option necessarily contains many columns, so the maximum number of decimal places 
that can be displayed is four. If you try to increase that number, the numbers may run together. You can increase 
the width of each column using this option. 

The recommended report column width for scenarios without large numbers of decimal places or extremely large 
sample sizes is 0.49. 

Options Tab 
The Options tab contains additional settings for this procedure.  

Options 

Number of Intervals within a Time Period 
The algorithm requires that each time period be partitioned into a number of equal-width intervals. Each of these 
subintervals is assumed to follow an exponential distribution. This option controls the number of subintervals. All 
parameters such as hazard rates, loss to follow-up rates, and noncompliance rates are assumed to be constant 
within a subinterval. 

Lakatos (1988) gives little input as to how the number of subintervals should be chosen. In a private 
communication, he indicated that 100 ought to be adequate. This seems to work when the hazard rate is less than 
1.0.  

As the hazard rate increases above 1.0, this number must increase. A value of 2000 should be sufficient as long as 
the hazard rates (h1 and h2) are less than 10. When the hazard rates are greater than 10, you may want to increase 
this value to 5000 or even 10000.  
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Example 1 – Finding the Power 
A non-inferiority trial is planned in which the primary analysis will use the non-inferiority logrank test. After 
extensive discussion, the researchers have decided that the upper bound on non-inferiority is 1.3.  

The trial will include a recruitment period of two-years after which participants will be followed for three more 
years. It is assumed that patients will enter the study uniformly over the accrual period. The researcher estimates a 
loss-to-follow rate of 5% per year in both the reference and experimental groups. Past experience leads to a base 
line hazard rate of 0.04. An equal sample allocation design will be used with a target power of 0.90 and 
significance level of 0.05.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Logrank Tests procedure window by expanding Survival, then Two Survival 
Curves, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Logrank Tests. You may then 
make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Power 
Alpha ....................................................... 0.05 
Group Allocation ..................................... Enter total sample size and percentage in Group 1 
Total Sample Size (N)............................. 1000 to 5000 by 1000 
Percent in Group 1.................................. 50 
HR0 (Non-Inferiority Hazard Ratio) ........ 1.3 
h1 (Hazard Rate of Reference Group) ... 0.04 
Accrual Time (Integers Only) .................. 2 
Accrual Pattern ....................................... Uniform or Equal 
Total Time (Integers Only) ...................... 5 
References Lost ...................................... 0.05 
References Switch to Treatment ............ 0.0 
Treatments Lost ...................................... 0.0 
Treatments Switch to Reference ............ 0.0 

Reports Tab 
Show Detail Numeric Reports ................ Checked 
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Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size ─────────────────────────────────────────── 
Hypotheses: H0: HR ≥ HR0   vs.   H1: HR < HR0 
 
        Acc-       
    Non-Inf Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N HR0 HR1 h1 Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.4665 500 500 1000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.5335 
0.7111 1000 1000 2000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.2889 
0.8528 1500 1500 3000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.1472 
0.9282 2000 2000 4000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0718 
0.9662 2500 2500 5000 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0338 
 
References 
Jung,Sin-Ho; Kang, Sun J.; McCall, Linda M.; Blumenstein, Brent. 2005. 'Sample Sizes Computation for 
   Two-Sample Noninferiority Log-Rank Test', J. of Biopharmaceutical Statistics, Volume 15, pages 969-979. 
Lakatos, Edward. 1988. 'Sample Sizes Based on the Log-Rank Statistic in Complex Clinical Trials', Biometrics, 
   Volume 44, March, pages 229-241. 
 
Report Definitions 
Power is the probability of rejecting a false null hypothesis. Power should be close to one. 
N1|N2|N are the sample sizes of the reference group, treatment group, and both groups, respectively. 
E1|E2|E are the number of events in the reference group, the treatment group, and both groups, respectively. 
Non-Inferiority Haz Ratio (HR0) is the upper bound for the hazard ratio that still leads to the conclusion of 
   non-inferiority. 
Actual Haz Ratio (HR1) is assumed to be the actual value of the hazard ratio. This is always set to 1. 
Ref Haz Rate (h1) is the hazard (instantaneous failure) rate of the reference group. Its scale is events per time 
   period. 
Accrual Time is the number of time periods (years or months) during which accrual takes place. 
Total Time is the total number of time periods in the study. Follow-up time = (Total Time) - (Accrual Time). 
Ref Loss is the proportion of the reference group that is lost (drop out) during a single time period (year or month). 
Trt Loss is the proportion of the treatment group that is lost (drop out) during a single time period (year or month). 
Ref to Trt (drop in) is the proportion of the reference group that switch to a group with a hazard rate equal to the 
   treatment group. 
Trt to Ref (noncompliance) is the proportion of the treatment group that switch to a group with a hazard rate equal to 
   the reference group. 
Alpha is the probability of rejecting a true null hypothesis. It should be small. 
Beta is the probability of accepting a false null hypothesis. It should be small. 
 

This report shows the values of each of the parameters, one scenario per row. We see that almost 4000 subjects 
will be required for this study. 
Next, a report displaying the number of required events rather than the sample size is displayed. 

 
Numeric Results in Terms of Events ─────────────────────────────────────────────── 
Hypotheses: H0: HR ≥ HR0   vs.   H1: HR < HR0 
 
        Acc-       
    Non-Inf Actual Ref  rual       
 Ref Trt Total Haz Haz Haz Acc- Time/   Ref Trt   
 Evts Evts Evts Ratio Ratio Rate rual Total Ref Trt to to   
Power E1 E2 E HR0 HR1 h1 Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.4665 66.8 73.8 140.6 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.5335 
0.7111 133.6 147.6 281.3 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.2889 
0.8528 200.4 221.5 421.9 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.1472 
0.9282 267.3 295.3 562.5 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0718 
0.9662 334.1 369.1 703.2 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0000 0.0000 0.0000 0.0500 0.0338 
 

Most of this report is identical to the last report, except that the sample sizes are replaced by the number of 
required events. 
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Next, reports displaying the individual settings year-by-year for each scenario are displayed. 
 
Detailed Input when Power=0.4510  HR0=1.30  HR=1.00  N=1000  Alpha=0.0500  Accrual/Total Time=2 / 5 
 
 Reference     Switch Switch 
 Hazard  Percent   Reference Treatment 
 Rate Percent Admin. Reference Treatment to to 
Time h1 Accrual Censored Loss Loss Treatment Reference 
Period (0.0400) (Equal) (Calc.) (0.0500) (0.0000) (0.0000) (0.0000) 
1 0.0400 50.00 0.00 0.0500 0.0000 0.0000 0.0000 
2 0.0400 50.00 0.00 0.0500 0.0000 0.0000 0.0000 
3 0.0400 0.00 0.00 0.0500 0.0000 0.0000 0.0000 
4 0.0400 0.00 50.00 0.0500 0.0000 0.0000 0.0000 
5 0.0400 0.00 100.00 0.0500 0.0000 0.0000 0.0000 
 

This report shows the individual settings for each time period (year). It becomes very useful when you want to 
document a study in which these parameters vary from year to year. 
Next, summary statements are displayed. 

 
Summary Statements ───────────────────────────────────────────────────────── 
A logrank test for non-inferiority against an upper hazard ratio bound of 1.30 with an overall 
sample size of 1000 subjects (500 in the reference group and 500 in the treatment group) 
achieves 46.65% power at a 0.050 significance level when the actual hazard ratio is 1.00 and 
the reference group hazard rate is 0.0400. The study lasts for 5 time periods of which subject 
accrual (entry) occurs in the first 2 time periods. The accrual pattern across time periods is 
uniform (all periods equal). The proportion dropping out of the reference group is 0.0500. No 
subjects drop out of the treatment group. The proportion switching from the reference group to 
another group with a hazard rate equal to the treatment group is 0.0000. The proportion 
switching from the treatment group to another group with a hazard rate equal to the reference 
group is 0.0000. 
 

 

Finally, a scatter plot of the results is displayed. 

Plots Section 
 

                
   

This plot shows the relationship between sample size and. Note that for 90% power, a total sample size of about 
4000 is required. The exact number will be found in Example 2.  
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Example 2 – Finding the Sample Size 
Continuing with the previous example, the researcher wants to investigate the sample sizes necessary to achieve 
80% and 90% power. All other parameters will remain the same as in Example 1. 

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Logrank Tests procedure window by expanding Survival, then Two Survival 
Curves, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Logrank Tests. You may then 
make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Power ...................................................... 0.80 0.90 
Alpha ....................................................... 0.05 
Group Allocation ..................................... Equal (N1 = N2) 
HR0 (Non-Inferiority Hazard Ratio) ........ 1.3 
h1 (Hazard Rate of Reference Group) ... 0.04 
Accrual Time (Integers Only) .................. 2 
Accrual Pattern ....................................... Uniform or Equal 
Total Time (Integers Only) ...................... 5 
References Lost ...................................... 0.05 
References Switch to Treatment ............ 0.0 
Treatments Lost ...................................... 0.05 
Treatments Switch to Reference ............ 0.0 

Output 
Click the Run button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size ─────────────────────────────────────────── 
Hypotheses: H0: HR ≥ HR0   vs.   H1: HR < HR0 
 
        Acc-       
    Non-Inf Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N HR0 HR1 h1 Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.8000 1344 1345 2689 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0500 0.0000 0.0000 0.0500 0.2000 
0.9000 1865 1866 3731 1.30 1.00 0.0400 Equal 2 / 5 0.0500 0.0500 0.0000 0.0000 0.0500 0.1000 
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Example 3 – Validation using Jung (2005) 
Jung et al. (2005) pages 974-975 present an example that will be used to validate this procedure. In this article, an 
8.8-year trial is presented in which patient accrual occurs the first 3.8 years. The baseline hazard rate is 0.0446. 
The value of HR0 is 1.3 and the value of HR is 1.0. Equal allocation between groups is used and uniform accrual 
is assumed. The significance level is 0.05 and the desired power is 0.90. Given these values, the number of events 
is found to be 499 and the sample size is 1891. 

Since this procedure using integer values for the accrual and trial time, the accrual time and total time will be set 
to 4 and 9 years, respectively.   

Setup 
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home 
window, load the Non-Inferiority Logrank Tests procedure window by expanding Survival, then Two Survival 
Curves, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Logrank Tests. You may then 
make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open 
Example Template. 

Option Value 
Design Tab 
Find (Solve For) ...................................... Sample Size 
Power ...................................................... 0.90 
Alpha ....................................................... 0.05 
Group Allocation ..................................... Equal (N1 = N2)  
HR0 ......................................................... 1.3 
h1 ............................................................ 0.0446 
Accrual Time ........................................... 4 
Accrual Pattern ....................................... Uniform or Equal 
Total Time ............................................... 9 
References Lost ...................................... 0.0 
References Switch to Treatment ............ 0.0 
Treatments Lost ...................................... 0.0 
Treatments Switch to Reference ............ 0.0 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results in Terms of Sample Size ─────────────────────────────────────────── 
Hypotheses: H0: HR ≥ HR0   vs.   H1: HR < HR0 
 
        Acc-       
    Non-Inf Actual Ref  rual       
    Haz Haz Haz Acc- Time/   Ref Trt   
    Ratio Ratio Rate rual Total Ref Trt to to   
Power N1 N2 N HR0 HR1 h1 Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.9000 933 933 1866 1.30 1.00 0.0446 Equal 4 / 9 0.0000 0.0000 0.0000 0.0000 0.0500 0.1000 
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Numeric Results in Terms of Events ─────────────────────────────────────────────── 
Hypotheses: H0: HR ≥ HR0   vs.   H1: HR < HR0 
 
        Acc-       
    Non-Inf Actual Ref  rual       
 Ref Trt Total Haz Haz Haz Acc- Time/   Ref Trt   
 Evts Evts Evts Ratio Ratio Rate rual Total Ref Trt to to   
Power E1 E2 E HR0 HR1 h1 Pat'n Time Loss Loss Trt Ref Alpha Beta 
0.9000 249.3 249.3 498.6 1.30 1.00 0.0446 Equal 4 / 9 0.0000 0.0000 0.0000 0.0000 0.0500 0.1000 
 

 

Note that the number of events (499) matches Jung’s results exactly. The sample size of 1866 is slightly less than 
Jung’s 1891. This difference occurs because these results were obtained for 4 years of accrual, not 3.8, and 
because we used Lakatos’ method for transforming the number of events into the sample size. 

Example 4 – Inputting Time-Dependent Hazard Rates from a 
Spreadsheet  
Time-dependent parameters (hazard rates, losses to follow-up, etc) may be entered. See Example 4 of Chapter 715 
(Logrank Tests) for an extensive example of how this is done for the logrank test. 
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